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Notes for the reader

Introduction

This manual helps you to use the Océ CS2224, Océ CS2236 and Océ CS2236MF . 
The manual contains a description of the product and guidelines to use and operate 
the Océ CS2224, Océ CS2236 and Océ CS2236MF . There are also tips to increase 
your knowledge of the product and to help you manage the workflow.

Definition

Attention Getters

Parts of this user manual require your special attention. These parts provide 
important, additional information or are about the prevention of damage to your 
properties. 

Note, Attention and Caution

The words Note, Attention and Caution indicate important parts.
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About this Manual

[1] 

Safety information

The safety information for this product is included in a separate manual with the title 
Safety information. This manual is part of the documentation set that you received 
with your product.

About this Manual

Introduction

This manual  gives information about the following aspects: 

■ How to use the Océ Printer Driver
A guideline for the installation and use of the Océ Printer Driver.

■ Installation and use of:
- Onyx GraphicsPro (Optional)
- Onyx CADPro (Optional)
Detailed information of the installation and use of Onyx GraphicsPro 
and Onyx CADPro .

■ How to install and use the Océ CS2236MF (Multi Functional) system
This chapter contains the following information:
- Installation of the Océ CS41xx Scanner 
Detailed information of the installation of the stand and the scanner.
- Installation of the Printer and the Printer Driver 
Information as a reference to the available documentation.
- Scanner Maintenance
Information as a reference to the available documentation.
- Installation and use of Océ Copy Easy (Optional)
Detailed information of the installation and use of Océ Copy Easy (Optional).

[1] The attention getters with the corresponding icons 

Word Icon Indicates

Note
[1] 

Additional information about the correct operation 
of the product or a tip.

Attention
[2] 

Information to prevent damage, for example to the 
product, an original or a file.

Caution
[3] 

Information to prevent personal injury. Caution is 
found only in manuals that describe physical 
products.
The Caution indication has several icons that warn 
against various hazards. The icons are shown in the 
table part below.
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- Installation of Onyx GraphicsPro (Optional) and Onyx CADPro (Optional)
Information as a reference to the available documentation.

■ How to troubleshoot the Océ CS22xx or the Océ CS2236MF.

The manual has references to the documentation that is available with the Printer or 
Scanner. 

Note: In case the information is in one of the two printer documents the indication 
is Océ CS22xx (instead of Océ CS2224 or Océ CS2236).

The following documentation  is available for the Océ CS2224 Printer:

■ Océ CS2224 Quick Start Guide  (as a printed document)
■ Océ CS2224 Reference Guide (on CD-ROM)
■ Océ CS2224 Users Guide (on CD-ROM)

The following documentation is available for the Océ CS2236 Printer:

■ Océ CS2236 Quick Start Guide (as a printed document)
■ Océ CS2236 Reference Guide (on CD-ROM)
■ Océ CS2236 Users Guide (on CD-ROM)

The following information is available for the Océ CS41xx scanners

■ Océ CS41xx scanners Installation Manual (on CD-ROM)
■ Océ Scanner Maintenance kit User Manual  (on CD-ROM)
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How to install the Océ Printer Driver

How to install the Océ Printer Driver

Before you begin

The installation of the Océ Printer Driver for Windows-based computers  is done 
after the installation of the Océ CS22xx printer. 
The installation of the Printer is given in the Océ CS22xx Quick Start Guide.

Install the  Océ Printer Driver (Example of a TCP/IP setup)

1. Insert the provided User Software CD-ROM in the CD-ROM drive
2. Open the Explorer.
3. Browse to the CD-ROM.
4. Open the folder CS2224 or CS2236.

[4] 

5. Open the folder 32-bit or 64-bit (XP / Vista version only).
[5] 

6. Open the folder Printer_Driver.
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[6] 

7. Open the folder WinXP_2K.
[7] 

8. Double-click on Setup.exe.
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How to install the Océ Printer Driver

[8] 

9. The Setup Wizard is started.
Select the required language.
Click on "Next".

[9] 

10. Read the software license agreement. 
Click on  "Yes" if agreed.
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How to install the Océ Printer Driver

[10] 

11. Select the "Manually Set Port to install".
Click on "Next".

[11] 

12. Select "Add Port".
[12] 

13. Select the port to add. 
Example: Standard TCP/IP Port.
Click on "OK".
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How to install the Océ Printer Driver

[13] 

14. The Add Standard TCP/IP Printer Port Wizard is started.
Click on "Next".

[14] 

15. Enter the Printer Name, IP Address and / or  Port Name.
Click on "Next".

[15] 

16. The Completing overview of the Port Wizard is shown. 
Click on "Finish".
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How to install the Océ Printer Driver

[16] 

17. The overview of the Set-up Wizard is given.
Click on "Next".

[17] 

18. Confirm the settings.
Click on "Start".

[18] 

19. The printer driver is now installed.
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How to install the Océ Printer Driver

[19] 

20. Select "Restart my computer now" and click on "Restart".
The Océ printer driver settings take effect after the restart of the computer.

[20] 

How to install the Status Monitor 

1. Insert the provided User Software CD-ROM in the CD-ROM drive
2. Open the Explorer.
3. Browse to the CD-ROM.
4. Open the folder CS2224 or CS2236.
5. Open the folder 32-bit or 64-bit (XP / Vista version only).
6. Open the folder Status_Monitor.
7. Double-click on Setup.exe.
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[21] 

8. The InstallShield Wizard is started.
[22] 

9. The Welcome screen is visible.
Click on "Next".

[23] 

10. Read the software license agreement. 
Select I accept the terms of the license agreement.
Click on "Next" if agreed.
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How to install the Océ Printer Driver

[24] 

11. Choose the Destination Location.
If needed: Browse to the required destination.
Click on "Next".

[25] 

12. The Ready to Install the Program screen is visible.
Click on "Install".

[26] 

13. The installation is started.
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[27] 

14. The InstallShield Wizard is completed.
Click on "Finish".

[28] 

The back channel communication with the printer  (Status of the printer, Ink level, 
etc. ) is now available.
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How to use the Océ Printer Driver

How to use the Océ Printer Driver

Introduction

The Océ Printer driver includes automatic settings for the available Océ Print Media.
The predefined Océ Print Preferences automatically select the correct Océ Media 
profiles and colour settings. 
This means you will get the same high quality result every time and consistent 
colours between various Océ media.

How to use the Océ Printer Driver

1. Open the file in a Windows application. 
2. Select "Print" from the "File" menu. 
3. Select the printer "Océ CS2224" or "Océ CS2236", and click "Preferences" or 

"Properties".
[29] 

4. On the "Main" tab, select the Media Type that is loaded in the printer.
[30] 

5. Open the "Page Setup" tab.
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[31] 

6. Set the "Page Size" to the original size, and specify the "Orientation (Portrait or 
Landscape)". 
By default the size of the printed image will be the same as the specified original 
size. 
If you want to zoom (scale) to a different size, enable "Enlarged / Reduced Printing" 
and specify your preferences. 
To save media, you can enable "Rotate Page 90 degrees" or open the "Layout" tab 
and select the option  "no spaces at top or bottom". 

7. Click "OK" to save your settings. 
8. Click on "Print" or "OK" to submit the file to the printer. 

Note: Detailed information about the Printer Driver is in the Océ CS22xx Users 
Guide,  Chapter:  Basic Printing Workflow or Software.
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How to use the Océ Printer Driver
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The Installation of Onyx CADPro or Onyx GraphicsPro

The Installation of  Onyx CADPro or Onyx GraphicsPro

Introduction

This document describes the installation of Onyx CADPro software. The installation 
of Onyx GraphicsPro is identical to the installation of Onyx CADPro.

Installation procedure: Dongle

1. Insert the USB Dongle (Hardlock) in the USB slot of the PC.
2. The Found New Hardware Wizard is started.

Select the "No" option and click on "Cancel".
[32] 

Installation procedure: Software program

1. Insert the DVD into the PC.
2. Wait for the automatic launch of the DVD 

or
Open the Explorer
Browse to the DVD
Double-Click on "install.exe" file.

3. The software installation of the dongle is started.
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[33] 

4. Click on "OK"
[34] 

5. The installation directory is shown. 
If necessary browse to another location.
Click on "Next".

[35] 

6. Activate the License agreement and click on "Install".
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The Installation of Onyx CADPro or Onyx GraphicsPro

[36] 

7. The installation of the program is started.
[37] 

8. Click on "Finish".
[38] 

9. The supported printers are shown.
Select a printer and click on "Install".

[39] 

10. Click on "Finish".
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[40] 

Installation: Registration  

1. After a short while the Registration window is activated.
Click on the "Request Registration Code" button. The registration is automatically 
done.

[41] 

2. In case the automatic registration was not possible, do the manual registration.
Write down the serial number (6 x 4 characters) and click on "OK".

[42] 

3. Browse to http://www.onyxgfx.com/register.
4. Fill in the form and click on "Register".



28 Chapter 2 Installation and use of Onyx CADPro or Onyx GraphicsPro (Optional)

The Installation of Onyx CADPro or Onyx GraphicsPro

[43] 

5. After several minutes you will receive an e-mail with the Registration code.
Copy / Paste the the registration code from the e-mail into the window.
Click on "Register".

[44] 

Installation: Network configuration (Example: TCP/IP)

1. Select TCP/IP Printer and click on the "Configure..." button.
[45] 

2. Enter the Host name or IP address and select the Data type or Port Name: 
<Port9100>) from the drop-down box. 
You can find the IP address of the printer via the printer menu: 
■ Option 1: Print status page: Test Print / Status Print 
■ Option 2: Read IP address: Maintenance / IP Settings /IP Address 
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Click on "OK".
[46] 

3. Activate the "Test" button to validate the TCP/IP address.
Click on "OK".

[47] 

4. Click on "OK". 
The installation, registration and configuration is finished.

[48] 
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The use of Onyx CADPro

The use of  Onyx CADPro

Introduction

This document describes the use of Onyx CADPro software.
The following options are described:

1. Use Onyx CADPro and the RIP-Queue
2. Use Onyx CADPro and the "Hot folder"
3. Use Onyx CADPro and Print over the network to a "Hot folder"

1. Use Onyx CADPro and the RIP-Queue

1. Start CADPro:
■ Double-click the CAD-Print desktop icon 

or
■ Browse to Start > All Programs > CADPro 7> CAD-Print

The CADPro RIP-Queue will also be launched in the background.
[49] 

A shortcut to the default 6 "Hot folders" is created on the desktop.
2. Select "Setup" and "Open" to send the CAD files.

Do
■ A: Select the file(s) to print 
■ B: Select the Printer
■ C: Select the Quick Set (predefined settings applied to files for specific workflow 

or media) 

Click on "Open" to start the processing.
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[50] 

3. CADPro processes all files in the background
[51] 

4. After processing the files, the processed files will be available in the CADPro 
RIP-Queue.
Indication in the CADPro RIP-Queue:
■ A: Processed file 
■ B: Select printer 
■ C: Click the "Print Now" button when the printer does not start automatically. 
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The use of Onyx CADPro

[52] 

2. Use Onyx CADPro and the "Hot folder"

1. Start CADPro:
■ Double-click the CAD-Print desktop icon 

or
■ Browse to Start > All Programs > CADPro 7> CAD-Print

The CADPro RIP-Queue will also be launched in the background.
[53] 

A shortcut of the "Hot folders" is created on the desktop.
2. Copy / Paste a HPGL/2 file from Windows Explorer to the shortcut of the  required 

"Hot folder" (Example: Oce CS2236PS CAD).
The file is printed.

Note: If you use the Drag and Drop function the file is dropped in the "Hot folder" 
and will be deleted.
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[54] 

3. Use Onyx CADPro and Print over the network to a  "Hot folder"

1. The shared Input folder on the  PC (with the CADPro installation) is used to print 
over the network. 

Note: Only a limited amount of known users (a Windows related issue) can 
simultaneous access this shared folder. For details contact your local IT 
administator.

[55] 

2. Activate "Start" -> "Run".
Fill in the network name of the PC (with the CADPro installation): Example 
pc1-wvg.
Click on "OK".

[56] 

3. Double-click on the "Input" folder.
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The use of Onyx CADPro

[57] 

4. The 6 "Hot folders" are shown.
[58] 

5. Copy / Paste a HPGL/2 file from Windows Explorer to the required "Hot folder".
The file is printed.

Note: If you use the Drag and Drop function the file is dropped in the "Hot folder" 
and will be deleted.
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The use of Onyx GraphicsPro

Introduction

This document describes the use of Onyx GraphicsPro software.

The following options are described:

1. Use Onyx GraphicsPro and the RIP-Queue
2. Use Onyx GraphicsPro and the "Hot folder"
3. Use Onyx GraphicsPro and Print over the network to a "Hot folder"
4. Use Onyx GraphicsPro and the virtual Postscript printer.

1. Use Onyx GraphicsPro and the RIP-Queue

1. Start GraphicsPro:
■ Double-click the CAD-Print desktop icon 

or 
■ Browse to Start > All Programs > GraphicsPro 7 > CAD-Print

2. Click on the "Open" button.
[59] 

3. Do
■ A: Select the Printer
■ B: Select the Quick Set (predefined settings applied to files for specific workflow 

or media)
■ C: Select the file(s) to print 

Click on "Open" to start the processing.
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The use of Onyx GraphicsPro

[60] 

4. The selected file is interpreted, rendered and added to the job list.
[61] 

5. Indication in the GraphicsPro RIP-Queue:
■ A: Processed file 
■ B: Select printer 
■ C: Click the "Print Now" button when the printer does not start automatically. 
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[62] 

2. Use Onyx GraphicsPro and the "Hot folder"

1. Start GraphicsPro:
■ Double-click the CAD-Print desktop icon 

or 
■ Browse to Start > All Programs > GraphicsPro 7> CAD-Print

The GraphicsPro RIP-Queue will also be launched in the background.
[63] 

A shortcut of the "Hot folders" is created on the desktop.
2. Copy / Paste a HPGL/2 file from Windows Explorer to the shortcut of the required 

"Hot folder" (Example: Oce CS2236PS CAD).
The file is printed.

Note: If you use the Drag and Drop function the file is dropped in the "Hot folder" 
and will be deleted.
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The use of Onyx GraphicsPro

[64] 

3. Use Onyx GraphicsPro and Print over the network to a "Hot folder"

1. The shared Input folder on the PC (with the GraphicsPro installation) is used to print 
over the network. 

Note: Only a limited amount of known users (a Windows related issue) can 
simultaneous access this shared folder. For details contact your local IT 
administator.

[65] 

2. Activate "Start" -> "Run".
Fill in the network name of the PC (with the GraphicsPro installation): Example 
pc1-wvg
Click on "OK".

[66] 

3. Double-click on the "Input" folder.
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[67] 

4. The 6 "Hot folders" are shown.
[68] 

5. Copy / Paste a HPGL/2 file from Windows Explorer to the required "Hot folder".
The file is printed.

Note: If you use the Drag and Drop function the file is dropped in the "Hot folder" 
and will be deleted.

4. Use Onyx GraphicsPro and the virtual Postscript printer

During the installation the Océ CS22xxPS Postscript printer drivers is installed.
The Postscript driver act like any other windows printer. 
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The use of Onyx GraphicsPro

This printer driver is shared by default. The driver sends a file to the rip-queue 
spooler.

[69] 
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Content and dimensions of the Box

Installation of the Océ CS41xx Scanner

Content and dimensions of the Box 

Introduction

The scanner is delivered in a box. 
This document describes the content and the dimensions of the box of the scanner.
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Océ CS4136/4142 content of the box
[2] 

Océ CS4136/4142 dimensions of the box
[3] 

Content Remark

Scanner

IEC and US power cable

3 m long USB cable with ferrite

3 m long FireWire (IEEE 1394) cable with 
ferrite

FireWire (IEEE 1394) cable 
between PC and scanner

Scanner Accessories Kit ■ Cleaning cloth
■ Original guides
■ Océ Scanner Maintenance 

Utility CD-ROM

SM (Scanner Maintenance) folder packed ■ Basic calibration sheet  with 
IT8 sheet (including floppy 
with reference file)

Dust cover

Scanner Maintenance kit

Stand (pedestal)

CD-ROM with Océ Colour Scanners User 
documentation

CD-ROM Pack

Optional

Note: All upgrade versions will 
contain an additional smart card.

Information Specification

Dimensions box 1480 x 720 x 590 mm
58.3 x 28.4 x 23.2 inch

Weight box Net / Gross: 85 kg / 124 kg.
Net / Gross: 187 lbs / 273 lbs. 
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Assemble the Stand of the Scanner

Introduction

This document describes the assembly of the scanner stand.

Required tool

Torx key (delivered with the scanner)

Illustration
[70] 

Assembly

1. Fix the 2 legs to the feet (2 x 2 Torx screws).

Note: Do not tighten the Torx screws.
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Assemble the Stand of the Scanner

[71] 

[72] 

2. Attach the base bar (with the holes at the bottom) to the 2 feet (2 x 3 Torx screws). 
[73] 

[74] 

3. Put the stand on the feet.
4. Fix the top bar to the legs (2 x 2 Torx screws).

Note: Watch the position of the sticker with the "Back" indication. 
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Assemble the Stand of the Scanner

[75] 

[76] 

5. Tighten all the 16 Torx screws. 
6. Mount the receiving rack.

[77] 
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Installation of the Scanner

Introduction

This document describes the installation of the scanner.

Required tool

Screw driver

Caution: 2 Persons are required to lift the scanner.

Install the scanner on the stand

1. Lock the wheels of the stand.
[78] 

2. Lift with 2 persons the scanner out of the box and position it on the stand.

Note: Place the scanner on the stand with the rear side at the "back" label of the 
top bar.
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Installation of the Scanner

[79] 

3. Check the position of the rubber feet:
- Position the rubber feet of the scanner in the key holes of the stand.

4. Fix the scanner to the stand with 4 screws.
[80] 

5. Open the cover.
Remove the foam.
Close the cover.

[81] 

6. Open the right hand side cover.
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[82] 

7. Connect the USB2 (or FireWire) cable to the scanner and guide the cable through the 
scanner to the rear side of the scanner.

Note: Do not connect the cable to the PC.

[83] 

8. Take the mains supply cable out of the box.
Connect the mains supply cable to the scanner.
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Installation of the Scanner

[84] 

9. Switch on the scanner.

Note: Let the exposure lamp of the scanner warm-up for at least 1 hour. 
Reason: Good scan quality.
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Complete the Scanner installation

Finalise the Scanner installation

1. Open the Scanner accessories box.
2. Place the 2 original guides on the scanner.

[85] 

3. Install the "Océ Scanner Agent" software on the customer PC.
For detailed information: See Scanner Maintenance kit User Manual Chapter 2.

4. Connect the (USB or FireWire (IEEE 1394)  cable) of the scanner to the customers 
PC.

5. Install the "Scanner Maintenance" software.
For detailed information: See Scanner Maintenance kit User Manual Chapter 3.

6. Store the remaining items in a cabinet.
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Installation of the Océ CS2236 Printer and the Océ Printer Driver

Installation of the Printer and Océ 
Printer Driver 

Installation of the Océ CS2236 Printer and the Océ Printer 
Driver

Introduction

This document indicates were to find the information for the installation of the Océ 
CS2236 Printer and Océ Printer Driver.

Installation procedure

1. The information for the installation of the Océ CS2236 Printer is available in the Océ
CS2236 Quick Start Guide.
Follow the description step by step.

2. The installation of the Océ Printer Driver is given in How to install the Océ Printer 
Driver on page 10 of this manual.
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Scanner Maintenance procedure 

Scanner Maintenance procedure

Scanner Maintenance procedure

Carry out the Scanner Maintenance procedure.
The Scanner Maintenance procedure is divided into three consecutive tasks:

■ Cleaning
■ Camera alignment
■ Calibration

Note: The scanner validation option in scanner maintenance is a successful tool to 
determine the need of cleaning or replacement of a consumable.

For detailed information see: Chapter 4 Scanner maintenance of the Océ CS41xx 
scanners.
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Installation and use  of Océ Copy Easy 
(Optional)

Installation of Océ Copy Easy

Introduction

This document describes the installation of the application Océ Copy Easy.

Before you begin

■ Check if the Océ Printer Driver is installed.
If not: The installation of the Printer Driver is given in the Océ CS2236 Quick 
Start Guide.

■ Check if Océ Scanner Agent detects the scanner.

How to install Océ Copy Easy

1. Insert the USB Dongle (Hardlock) in the USB slot of the PC.
2. Insert the CD-ROM into the PC.
3. Wait for the automatic launch of the CD-ROM 

or
Open the Explorer
Browse to the CD-ROM
Double-Click on "setup.exe" file.

4. Select the language and click "OK".
[86] 

5. Click on "Next.
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[87] 

6. Click on "Yes" to accept the License Agreement.
[88] 

7. Click "Next" to install the application.
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Installation of Océ Copy Easy

[89] 

8. Click "Finish" to finalise the installation.
[90] 
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Registering of Océ Copy Easy (New Install)

Introduction

This document describes the registering of Océ Copy Easy.
Prior to the use of Océ Copy Easy, you must register your software by entering your 
code manually. 

The window for licensing the software appears automatically at first start. 
You will find the keycode target and the code in the product box. 
After licensing, the code is shown in the window "Hardware".

Note: The keycode is case sensitive. The fonts will be red until the code is complete 
and error-free.

Enter the keycode

1. Write the keycode in the empty field.
2. Reboot the computer
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Registering of Océ Copy Easy (As an upgrade)

Introduction

This document describes the registering of Océ Copy Easyversion 8.3 as an update 
of Océ Copy Easy 8.2.

Note: The keycode is case sensitive. The fonts will be red until the code is complete 
and error-free.

Retrieve the current keycode

1. Start Océ Copy Easy 8.2.
2. Go to "Configuration" / "Hardware".
3. Copy the key code.
4. Close Océ Copy Easy 8.2.

Enter the keycode

1. Start Océ Copy Easy 8.3.
2. Go to "Configuration" / "Hardware".
3. Paste the key code and select OK.

Note: Uninstall Océ Copy Easy 8.2.
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The configuration of Océ Copy Easy

Introduction

This document describes the configuration of Océ Copy Easy.

How to configure Océ Copy Easy

1. Start the Océ Copy Easy application.
The Océ Copy Easy window and a Hardware window appears.

[91] 

2. Select at the Scanner window the connected scanner. 
Example: Océ CS4142.

3. Double-Click in the available Printers window, the printer you want to install. 
Example: Océ CS2236

4. A printer configuration window will pop-up.
Enter the printer connection information according to your set-up.



60 Chapter 3 How to install and use the Océ CS2236MF

The configuration of Océ Copy Easy

[92] 

5. Click on "Next".
6. Click on "Finish".
7. Click on "OK" in the Hardware window.
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How to make a copy with Océ Copy Easy

Introduction

This document describes how to make a copy with Océ Copy Easy.

How to make a copy with Océ Copy Easy

1. Start Océ Copy Easy.
[93] 

2. Set the "Original Size".
3. Set the "Copy Size".
4. Select   "Colour" or "B/W".
5. Select the "Original Type".
6. Click on the "Copy" button.
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How to make a scan with Océ Copy Easy

Introduction

This document describes how to make a scan with Océ Copy Easy.

How to make a scan with  Océ Copy Easy

1. Start Océ Copy Easy.
2. Select File > Scan into File Mode.

[94] 

3. Select the File format.
4. Select the File name.
5. Set the "Original Size".
6. Set the "Output Size".
7. Select "Colour" or "B/W".
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8. Select the "Original Type".
9. Click on the "Scan" button.
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Installation and use of Onyx 
GraphicsPro or Onyx CADPro (Optional)

Installation and use of Onyx CADPro or Onyx GraphicsPro 
(Optional)

Installation and use of Onyx CADPro or Onyx GraphicsPro

For detailed information about the installation and use of Onyx CADPro or Onyx 
GraphicsPro: 
See chapter 2 Installation and use of Onyx CADPro or Onyx GraphicsPro in this 
Manual.
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How to troubleshoot the Océ CS22xx or Océ CS2236MF

How to troubleshoot the Océ CS22xx or Océ CS2236MF

Introduction

The document gives an overview of the troubleshooting workflow for the Printer, 
Scanner, Driver or Applications  of the system.
Detailed information is given as well as references to the available documentation to 
troubleshoot the system. 

Step 1: Troubleshoot the Océ CS22xx Printer Hardware

Detailed trouble shooting information is available in the Océ CS22xx  Users Guide. 
Have a look in the following chapters of the Users Guide

■ Troubleshooting
■ Error Message
■ Handling Paper

Step 2: Troubleshoot the Océ Printer Driver

Detailed trouble shooting information is available in the Océ CS22xx Users Guide. 
Have a look in the following chapter of the Users Guide

■ Software

Step 3: Troubleshoot the Océ CS22xx Printer Quality

Detailed trouble shooting information is available in the Océ CS22xx Users Guide. 
Have a look in the following chapter of the Users Guide

■ Enhanced Printing Options

Step 4: Troubleshoot the Océ CS41xx Scanner Hardware

Detailed trouble shooting information is available in the Océ CS41xx Scanners 
Installation Manual. 
Have a look in the following chapter of the Manual:

■ Chapter 5 Troubleshooting

Note: The scanner validation option in scanner maintenance is a successful tool to 
determine the need of cleaning or replacement of a consumable.
For detailed information see: Chapter 4 Scanner maintenance.
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Step 5: Troubleshoot the Océ CS41xx Scanner Quality

Detailed trouble shooting information is available in the Océ CS41xx Scanners 
Installation Manual. 
Have a look in the following chapter of the Manual:

■ Chapter 4 Scanner maintenance

Step 6: Troubleshoot Océ Copy Easy (Optional)

The following steps are possible to troubleshoot Océ Copy Easy:

■ Check the scanner indicator (coloured circle):
- Green colour: The system is OK
- Other colour: Move the cursor on the text of the scanner. 
Check the information. Examples: Not connected, Sleep mode, ...

■ Check the colour of the copy button:
- Green colour: The system  is OK.
- Other colour: Move the cursor over the copy button. 
Check the information. Examples: Media to small, ... 

■ The Quality still not OK
- Step 1: Original type selection is not correct. Select a different original type. 
Example: Mixed Originals. 
- Step2: Selected media not correct: Example: Photo on Draft paper is not correct. 
Select an other media type.
- Step 3: Original and Media is correct. Do a Calibration (Closed Loop 
Calibration): 
Select "Configuration" > "Calibration".
Click on the "Print target" Button.
Feed the Printed file in the middle of the scanner.
Select "Scan Target".
The Printed file is scanned by the scanner.
The calibration is done
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How to troubleshoot the Océ CS22xx or Océ CS2236MF

[95] 

Step 7: Troubleshoot Onyx GraphicsPro or Onyx CADPro (Optional)

Do the following steps to start the troubleshooting of Onyx GraphicsPro or Onyx 
CADPro:

■ Check the network cable.
■ Check if the IP address of the printer, as used in in the driver, is correct.

Report the problem to Océ

Before you report the problem to Océ, make sure you have done the necessary 
troubleshooting steps, as indicated in the step 1 ... 7  above.
Check that you have the following information is available for the Océ Helpdesk:

■ Serial number of the printer.
■ Serial number of the scanner.
■ Used driver or application.
■ A good problem description.
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Reader's comment sheet 

Questions

Have you found this manual to be accurate? 
O Yes 
O No

Were you able to operate the product, after reading this manual? 
O Yes 
O No 

Does this manual provide sufficient background information? 
O Yes 
O No 

Is the format of this manual convenient in size, readability and arrangement (page 
layout, chapter order, etc.)?
O Yes 
O No 

Could you find the information you were looking for? 
O Always 
O Most of the times 
O Sometimes 
O Not at all 

What did you use to find the required information? 
O Table of contents 
O Index 

Are you satisfied with this manual?
O Yes 
O No 

Thank you for evaluating this manual.
If you have other comments or concerns, please explain or suggest improvements 
overleaf or on a separate sheet. 

Comments:
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------
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Reader's comment sheet

Date:

This reader's comment sheet is completed by: 
(If you prefer to remain unknown, please do fill in your occupation) 

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to: 

Océ-Technologies B.V.
For the attention of ITC User Documentation. 
P.O. Box 101, 
5900 MA Venlo
The Netherlands 

Send your comments by E-mail to: itc-userdoc@oce.com 

For the addresses of local Océ organisations see: http://www.oce.com 
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Addresses of local Océ organisations 
[4] 

Océ-Australia Ltd. 
P.O. Box 363
Ferntree Gully MDC
Vic 3165
Australia
http://www.oce.com.au/ 

Océ-Österreich GmbH 
Postfach 95
1233 Vienna
Austria
http://www.oce.at/

Océ-Belgium N.V./S.A. 
J. Bordetlaan 32
1140 Brussel
Belgium
http://www.oce.be/

Océ-Brasil Comércio e Indústria Ltda.
Av. das Nações Unidas, 11.857 
Brooklin Novo
São Paulo-SP 04578-000
Brasil
http://www.oce-brasil.com.br/ 

Océ-Canada Inc. 
4711 Yonge Street, Suite 1100 
Toronto, Ontario M2N 6K8
Canada
http://www.oce.ca/

Océ Office Equipment (Beijing) Co., Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China
http://www.oce.com.cn/

Océ-Czech Republic ltd.
Hanusova 18
140 21 Praha 4
Czech Republic
http://www.oce.cz/ 

Océ-Danmark a/s 
Vallensbækvej 45
2605 Brøndby
Denmark
http://www.oce.dk/ 

Océ Finland OY
Valkjärventie 7 D, PL 3 
02130 Espoo
Finland
http://www.oce.fi/

Océ-France S.A. 
32, Avenue du Pavé Neuf
93161 Noisy-le-grand, Cedex 
France
http://www.oce.fr/

Océ-Deutschland GmbH
Solinger Straße 5-7
45481 Mülheim/Ruhr
Germany
http://www.oce.de/ 

Océ-Hong Kong and China head office
12/F 1202 The Lee Gardens
33 Hysan Avenue 
Causeway Bay
Hong Kong
http://www.oce.com.hk/
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Océ-Hungaria Kft.
1241 Budapest
Pf.: 237
Hungary
http://www.oce.hu/

Océ-Ireland Ltd.
3006 Lake Drive 
Citywest Business Campus
Saggart
Co. Dublin
Ireland
http://www.oce.ie/

Océ-Italia S.p.A. 
Strada Padana Superiore 2/B 
20063 Cernusco sul Naviglio (MI) 
Italia
http://www.oce.it/ 

Océ Japan Corporation
3-25-1, Nishi Shinbashi
Minato-Ku
Tokyo 105-0003
Japan
http://www.ocejapan.co.jp/

Océ-Belgium S.A.
Rue Astrid 2/A
1143 Luxembourg-Belair
http://www.oce.lu/

Océ Malaysia Sdn. Bhd.
#3.01, Level 3, Wisma Academy 
Lot 4A, Jalan 19/1 
46300 Petalig Jaya 
Selangor Darul Ehsan
Malaysia
http://www.ocemal.com.my/

Océ-Mexico S.A. de C.V. 
Prolongación Reforma 1236, 
4to Piso 
Col. Santa Fé, Del. Cuajimalpa 
C.P. 05348 
México, D.F. 
México
http://www.oceusa.com/

Océ-Norge A.S. 
Postboks 4434 Nydalen
Gjerdrums vei 8
0403 Oslo
Norway
http://www.oce.no/

Océ-Poland Ltd. Sp.z o.o. 
ul. Bitwy Warszawskiej 1920 r. nr. 7 
02-366 Warszawa  
Poland
http://www.oce.com.pl/ 

Océ-Lima Mayer, S.A.
Av. José Gomes Ferreira, 11 Piso 2 - 
Miraflores
1497-139 Algés
Portugal
http://www.oce.pt/

Océ Singapore Pte Ltd.
190 MacPherson Road
#03-00 Wisma Gulab 
Singapore 348548 

Océ Printing Systems (PTY) Ltd.
P.O.Box 629
Rivonia 2128
South Africa
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Note: The web site http://www.oce.com gives the current addresses of the local Océ 
organisations and distributors.

Note: The addresses of local Océ organisations for information about the Wide 
Format Printing Systems and the Production Printing Systems can be different from 
the addresses above. Refer to the web site http://www.oce.com for the addresses you 
need.

Océ España SA 
Business Park Mas Blau
Osona, 2 08820 El Prat de Llobregat
Barcelona
Spain
http://www.oce.es/ 

Océ-Svenska AB
Sollentunavägen 84
191 27 Sollentuna 
Sweden
http://www.oce.se/

Océ-Schweiz AG 
Sägereistrasse 10
CH8152 Glattbrugg
Schweiz
http://www.oce.ch/

Océ (Thailand) Ltd. 
B.B. Building 16/Floor
54 Asoke Road
Sukhumvit 21
Bangkok 10110
Thailand

Océ-Nederland B.V. 
P.O.Box 800 
5201 AV 's-Hertogenbosch 
The Netherlands
http://www.oce.nl/ 

Océ (UK) Limited 
Océ House
Chatham Way
Brentwood, Essex CM14 4DZ 
United Kingdom
http://www.oce.co.uk/

Océ North America Inc.
5450 North Cumberland Avenue
Chicago, IL 60656
USA
http://www.oceusa.com/
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